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Welcome to HTMASC, the easy and fast way to convert pages from the World Wide Web 
(*.htm) to plain Textfiles (*.txt).
All of the HTML tags (e.g.<TITLE>, <HEADER> ...) are removed and entities (&quot; 
&copy; ....) are converted.
HTMASC also offers full text handling capabilities. You get all the standard features like 
searching for text, using the Clipboard, printing... and you get nice extras like bookmarks 
and a powerful undo facility.
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What's NEW in Version 2.0
New:    History List Window

New: Multiple Convert Dialog

New: Configure Lights Dialog

New: Select from a list of previously entered Output Directories

Added: New options to the Options Dialog

Added: Find Dialog displays the word at the cursor position

Added:    New Lights to the Options Speed Bar

Added: Navigation Buttons to the Toolbar

Added: Right Mouse Button now works in the following places:
· Converted File Window
· Options Speed Bar
· History List Window

Changed:    Pricing and Ordering Information

Changed : Option Show Links : URL's are now in all lowercase (Some Browsers had problems 
with an uppercase-address)

Fix: Improved detection of Mac/Unix/DOS Files



Introduction to HTMASC

Load a HTML File, click on        and the converted textfile will show up in the bottom 
window! That's all you have to do to convert Webpages into a    more readable format. It's 
that easy!

Now the screen should look something like this:

Note: For Help with an area of the Main Window click on it in the picture below



Original File Window
After loading a HTM - File the original text can be viewed. That's only for reference, no 
editing, copying, searching etc. is possible.



Converted File Window
The converted file can be fully edited using the mouse or standard CUA keystrokes. You can 
search for text, cut, copy, paste, undo, redo ... 
Note: The right mouse button displays a PopUp Menu for quick access to most of the Menu 
commands.



Bookmark
You can define up to 10 Bookmarks in the editor



Selected Text
You can cut, copy or delete the selected text



Shows the full name of the HTM - File



Shows the full name of the converted Textfile



The Toolbar allows quick access to most of the commands



Shows the full path of the current Output Directory



The Options Speed Bar provides shortcuts
for commands from the Options Dialog.



You can vertically resize the File Windows by dragging the separator line that lies between 
the Converted File Label    and the Original File Window.



Shows the number of currently visible columns.



Loading *.htm Files

Use the  icon from the Toolbar or choose File|Open from the Menu to show the Open File 
Dialog box.
To select more than one file to be converted in one pass use the  icon from the Toolbar to 
show the Multiple Convert Dialog



HTMASC Features
Some of the features in alphabetical order:

Bookmarks

File Size

History List Window

Multiple Convert Dialog

Options Speed Bar

Output Directory

PopUp Menu

Resizable Windows

Toolbar

Undo/Redo

Window Size and Position

Word Wrap



Bookmarks
Bookmarks provide a means of moving quickly from place to place within a file.

You can define up to 10 Bookmarks.

To set a bookmark, press <CtrlShiftN> where N is a number in the range 0 to 9. To return to 
that spot later, press <CtrlN>, where N is the number used to set the bookmark.

Clicking the right mouse button in the Converted File Window    displays a PopUp Menu for 
quick access to most of the Menu commands including Bookmark actions.



Toolbar
Below the Menubar you see a row of buttons called the Toolbar. Toolbar buttons perform an 
action, just like a menu selection. Using a Toolbar button couldn't be easier    just click on it. 

Greyed Out Buttons
Toolbar buttons that are not currently available appear greyed out. 

Getting Help with a Toolbar Button
To find out what a Toolbar button does, point at it with the mouse. HTMASC will display a 
short explanation of the button's action.

        Exit the application

      Open a HTM - File

      Open the Multiple Convert Dialog

      Start the conversion

      Save the    converted file

      Save the converted file under a different name

      Cut selected text to the clipboard

      Copy selected text to the clipboard

      Paste from clipboard

      Open the Find Dialog Window

      Search again

      Previous File in history

      Next File in history



HTMASC can handle files up to a limit of 16MB.



Undo/Redo
The Converted File Window provides a undo facility that allows multiple edit commands to be
undone.
You can either choose Undo/Redo from the Edit Menu or you can use the following 
keystrokes:

Undo          <CtrlZ> or <AltBkSp>
Redo          <ShiftCtrlZ>

Note: The editor stores a record of each edit command in a single continuous buffer, which is
64KB. This is also the maximum which can be undone in one step.



Output Directory
Using the Options Dialog you can specify the directory    to store your converted textfiles 



· Clicking the right mouse button in the Converted File Window    displays a PopUp Menu 
for quick access to Bookmarks and most of the Menu commands.

· Clicking the right mouse button while the cursor is over the Options Speed Bar (OSB) 
displays a PopUp Menu with entries for    Hiding/Showing the OSB and for configuration of
the OSB.



Adapts the text in the Converted File Window to the actual size of the window.



Window Size and Position
If the Save Window Position Checkbox in the Options Dialog is activated(Default) the last 
window size and position is saved when you exit HTMASC.



HTMASC Menus
File Menu

Edit Menu

Search Menu

Options Menu

Help Menu



File Menu
The File menu enables you to open, save, convert and print files.
Note: Most of the commands are also available from the Toolbar

Open        
Loads an existing HTML File

Convert        
Starts the conversion

Multiple Convert      
Opens the Multiple Convert Dialog

Save        
Saves the file in the Converted File Window using its current name

Save As...        
Saves the file in the Converted File Window using a new name

History List...
Opens the History List Window

Print
Sends the file in the Converted File Window to the printer

Print Setup
Opens the Printer Setup Dialog box

Exit        
Closes the open files and exits HTMASC



History List Window
After converting at least 2 Files choose File|History List... to show the History List Window.
Keyboard: Use <Ctrl - H> to switch from the Main Window to the History List and use <Ctrl - 
M> to switch back to the Main Window.

The History List Window is used to select Files for viewing and/or editing which have been 
already converted during a session. Double Click on a Filename or press <ENTER> and the 
selected File will show up in the Main Window of HTMASC.
Alternatively you may browse through these Files using the 

    buttons on the Toolbar
Keyboard: <Ctrl - P> for previous File, <Ctrl - N> for next File.

The RMB shows a PopUp Menu with the following entries:
· Always On Top: The History List remains on top of the Main Window
· Close: Close History List Window



Edit Menu
The Edit menu enables you    to manipulate text in the Converted File Window
Note: Most of the commands are also available from the Toolbar

Undo
Undoes your last action or last deletion

Redo
Reverses an undo

Cut        
Removes selected text and places it on the Clipboard

Copy        
Places a copy of the selected text on the Clipboard, leaving the original in place

Paste        
Copies the contents of the Clipboard into the Converted File Window

Delete
Removes the selected text

Select All
Selects all the text in the Converted File Window



Search Menu
The Search menu enables you to locate text in the Converted File Window.
Note: These commands are also available from the Toolbar

Find        
Opens the Find Dialog Window

Find Next        
This will find the next match for the specified text, starting from the current cursor position.



Find Dialog Window
Use this dialog box to specify text you want to locate, and to set options that affect the 
search.

Note: For Help with an area of the Find Window click on it in the picture below



Enter a search string



Searches from the current position to the end of the file



Searches from the current position to the beginning of the file



Differentiates uppercase from lowercase when performing a search



Searches the entire file



Multiple Convert Dialog
The Multiple Convert Dialog is used to select a number of files to be converted in one pass. 
You can choose files from different directories and the converted files will all be saved in the 
Output Directory .    If    the Same Directory Option is active, the Converted Files are stored in 
the directory of the corresponding    *.htm File.

Note: For Help with an area of the Multiple Convert Window click on it in the picture below



Select File(s) to convert.
To add Files to the list use one of the following methods:
· Double Click on a Filename
· Select File(s) and use the Move One Button or press <ENTER>
· Use the Move All Button



Displays the File(s) that will be converted in one Pass.
To remove Files from this list use one of the following methods:
· Double Click on a Filename
· Select a File and use the Remove One Button or press <DEL>
· Use the Remove All Button



Select Directory



Select Drive



If ON:
Disable ALL warnings during Multiple File Processing
Note: To set this option permanently use the Options Dialog



Starts the Multiple File Conversion



Move complete directory to the Convert List



Move selected File(s) to the Convert List



Remove selected File from the Convert List



Remove all Files from the Convert List



Options Menu
Use the Options menu to view and change project and environment settings

Word Wrap
Adapts the text in the Converted File Window to the actual size of the window.

Show Lights
Shows the Options Speed Bar. 

Configure Lights...
Shows the Configure Lights Dialog

More...
Opens the Options Dialog Window.



Options Dialog
Use the Options Dialog to view and change project and environment settings.

Alternatively you may use the Options Speed Bar for quick access to most of the options.

Note: For Help with an area of the Options Window click on it in the picture below



Displays the current output directory and    you can enter a new output directory.
If the directory does not yet exist, HTMASC will ask to create it.



Opens the Select Directory Dialog Window



Select Directory Dialog
Use the Select Directory Dialog box to choose a    directory for your converted textfiles.

Note: For Help with an area of the Select Directory Window click on it in the picture below



Displays the current output directory and    you can enter a new output directory.
If the directory does not yet exist, HTMASC will ask to create it.



Select Drive



Select Directory



If ON:
Popup Hints are shown



If ON:
Saves the last window size and position



If ON:
Document Title is shown in the converted file



If ON:
Disables ALL! Warnings during Multiple-File-Processing.



If ON:
Existing Files are renamed with the extension 'BAK'



If ON:
Skips blank lines in the converted File



If ON:
Minimize Main Window during Multiple-File-Processing.



Options Speed Bar
The Options Speed Bar (OSB) serves two purposes:
1) To provide shortcuts for commands from the Options Dialog by clicking on the 

corresponding light.
2) To give quick visual feedback of the presently selected options.

To Show/Hide the OSB use Show Lights from the    Options Menu.

To configure the OSB use the Configure Lights Dialog

The RMB shows a PopUp Menu with the following entries:
· Show Lights: Toggles Show/Hide the OSB
· Configure Lights...: Opens the Configure Lights Dialog

Note: For Help with an area of the OSB click on it in the picture below



Show Hints
If ON:
Shows these Popup Tooltips



Save Window Position
If ON:
Saves the last window size and position



Output OEM (DOS)
If ON:
Converted File is saved in OEM (=DOS) Format.
File extension is *.ASC.



Show Links
If ON:
Shows all ULRs (HREF="xxx...") in the converted file.



Same Directory
If ON:
Converted Files are stored in the directory of the currently open *.htm File.



Show Title
If ON:
Document Title is shown in the converted file



Disable Multi-Warnings
If ON:
Disables ALL! Warnings during Multiple-File-Processing.



Make Backup *.BAK
If ON:
Existing Files are renamed with the extension 'BAK'



Compress Empty Lines
If ON:
Skips blank lines in the converted File



Minimize / Multi-Proc
If ON:
Minimize Main Window during Multiple-File-Processing.



Configure Lights Dialog
Use the Configure Lights Dialog to set the visible lights of the Options Speed Bar

Note: For Help with an area of the Configure Lights Dialog click on it in the picture below



Use this button to set all lights to be visible on the OSB.



Select/Deselect a checkbox to Show/Hide the corresponding Light



Help Menu
Contents
Opens the Help file. The online Help provides a contents screen that summarizes the 
contents of the HTMASC Help system. 
Note: If you do not know how to use Help in Windows, choose Help|How To Use Help from the
menu bar.

Topic Search
Displays the Help Search dialog box. The Search dialog box lets you search for Help topics 
using keywords.

How To Use Help
Displays information on how to use the Windows Help system.

Register
Displays the Register Dialog where you can enter your registration key to turn your 
Shareware version of HTMASC into the registered version.
Only You can make a Smiley SMILE!

About
Shows the About HTMASC dialog box with copyright and version information.



Frequently Asked Questions
I'm trying to open a HTML File and I get the error message: "Unknown filetype ..."

When I click on the Smiley button nothing happens, why?

My Registration Key doesn't work.

I can't enter a new Output Directory

Why is the file ENTITIES.HTM included?

How can I resize the Converted File Window?



Error message: "Unknown filetype ..."
Prior to loading a HTML File HTMASC has to determine its type (DOS or UNIX) to allow a 
proper file handling. The main difference between DOS and UNIX files is the character used 
for end of paragraph . DOS uses a combination of CRLF (Carriage return - Line feed) while 
UNIX uses only LF.

Note: Filetype Detection should have improved in Version 2.0. If you still see this message 
please send me that file so I can have a look at it.



Smiley button
It serves NO specific purpose.

BUT after registering HTMASC    Smiley's mood changes from     to 
 !

Only You can make a Smiley SMILE!



Registration Key Problem
If you encounter a problem when you try to register HTMASC, please make sure to verify the 
following:

· The User Name must be identical to the name you sent me for registration

· The Registration Key must be entered exactly

· The Program Version must be the same that you have registered for.

There is also the possibility that you have found a bug, please send me your name,    the 
version number of HTMASC    and your registration key by E-Mail. I'm sure we will find a 
solution!



I can't enter a new Output Directory
Check if the 'Same Directory' Option is selected.
You can change this setting using the Options Dialog or click on the SD - Light of the Options 
Speed Bar.



This file contains all of the HTML Entities.
I included it to prove that HTMASC is able to convert ALL of these Entities.

You might as well use it to compare HTMASC to other conversion programs ;-)



Pricing and Ordering Information
Alternative Ordering Information

This version of HTMASC is SHAREWARE. The registration price is US$25.-    for a single user 
license.

Registration benefits:
When you register, you'll get a key which disables the Shareware Reminder Screen, puts 
your name into the title bar, makes the Smiley smile, enables technical support by E-Mail 
AND you get

2 WINDOWS BONUS PROGRAMS!

            RWATCH    and
            STAMP IT!

for FREE!
Plus:
· Automatic email notification of product updates
· Free minor updates
· Discounts on major upgrades

Ordering HTMASC
For your convenience we have contracted another company, NorthStar Solutions, to process 
any orders you may wish to place with your VISA, MASTERCARD or DISCOVER card.
NorthStar Solutions can be easily contacted FOR ORDERS ONLY via any of the following 
methods:

Important Note! Please state clearly in your order to NorthStar Solutions that you would 
like to register VERSION 2.x !

Phoned Orders:
Calls are taken 10 am - 8 pm, EST, Monday thru Saturday.
1-800-699-6395 (Calls from the U.S. only)
1-803-699-6395 (International calls)

Faxed Orders:
1-803-699-5465 (Available 24 hours. International and business orders    encouraged)

E-Mailed Orders:
CompuServe: 71561,2751
America Online: STARMAIL
Internet: 71561.2751@compuserve.com
World Wide Web: http://ourworld.compuserve.com/homepages/starmail

Mailed Orders:
You may register with a check or money order (U.S. currency).
Make them payable to "NorthStar Solutions" and send them to:

PO Box 25262
Columbia, SC 29224

Please provide (or be prepared to provide) the following information when ordering:
· The program and version you are registering
· Your mailing address
· Your Visa, MasterCard, or Discover # and its expiration date (if using credit card)



· Your E-Mail address (so NorthStar Solutions can send you an E-Mail confirming your order
and so I can contact you with your registration key, any important follow-up information, 
upgrade announcements, etc.)

IMPORTANT:
NorthStar processes registrations ONLY, please contact the author for any product/technical 
support.

Alternative Ordering Information



Monitors System Resources (WIN)



Changes DATE/TIME of    selected files (WIN)



Alternative Ordering Information
This version of HTMASC is SHAREWARE. The registration price is US$25.-    for a single user 
license.

Ordering HTMASC

There are a number of ways to order HTMASC from us.    When we receive your payment, we 
will e-mail you the serial number to register HTMASC.

CompuServe
Compuserve Shareware Registration Service (GO SWREG, registration ID is #13573).

Credit Card
A registration form for Credit Card Orders (VISA only!) is available on:

http://ourworld.compuserve.com/homepages/bite/register.htm

Alternatively you may send us your credit card details by    post or    e-mail

Cash
We will accept cash in 
US    dollars ($25.-),
German Marks (DM40.-)
or Austrian Shillings (S250.-).
However, we will take no responsibility for the cash while it's in transit. For your own 
protection if you want to pay in cash, we strongly recommend sending it to us by registered 
mail.
Note: Make sure to include your E-Mail address!!!

Registration benefits:
When you register, you'll get a key which disables the Shareware Reminder Screen, puts 
your name into the title bar, makes the Smiley smile, enables technical support by E-Mail 
AND you get
2 WINDOWS BONUS PROGRAMS!

            RWATCH    and
            STAMP IT!

for FREE!

How to get the latest version
 The prefered source of information about HTMASC is our Web site:

http://ourworld.compuserve.com/homepages/bite

You may also try the following forums on Compuserve:

INETRESOURCE    Lib9 / WWW/Hypertext Tools
WINSHARE    Lib11 /Internet/HTML
PCUTIL    Lib4/Windows
PCONLINE    Lib9 / Internet



How to reach us

Compuserve: Walter Novacek 100341,240

Internet: 100341.240@compuserve.com

Fido: Walter Novacek@2:310/39.15

You can also use snail mail:

BITE'n'BYTE SOFTWARE
Walter Novacek
Kirchstetterng.56/12
A-1160 Vienna
AUSTRIA



Updating from HTMASC 1.x
Update Price is US$ 10.- 

Users who have registered HTMASC 1.x    AFTER    01-Sept-1996 will NOT be charged for 
the update. Please contact the author by EMail.

If you have registered HTMASC 1.x    PRIOR TO 01-Sept-1996 you can update to Version 
2.0 using one of the following methods:

NorthStar Solutions Ordering Service
Important Note! Please state clearly in your order to NorthStar Solutions that you would 
like to register the UPDATE from 1.x to 2.x !
Detailed NorthStar Solution ordering instructions: Pricing and Ordering Information

CompuServe
Compuserve Shareware Registration Service (GO SWREG, Update ID is #13574).

BITE'n'BYTE Homepage
http://ourworld.compuserve.com/homepages/bite



Credits and Copyrights
HTMASC is the    registered trademark of    Bite'n'Byte Software.

For Product License Information please read LICENSE.TXT.

This product uses several components from TurboPower Software's Orpheus package.
Special Thanks to Lee Inman from TurboPower Software for his great support.

Thanks to Nick Hodges for his TSmiley, the Delphi Component of the century!



Contacting the Author
The preferred source of information about HTMASC is our Web site:

http://ourworld.compuserve.com/homepages/bite

Here you can download updates and bug fixes to HTMASC, follow links to a number of HTML 
resources on the Web, subscribe to our mailing list and much more.

Technical Support

Technical support for HTMASC is available by e-mail    to registered users only.

Compuserve: Walter Novacek [100341,240]

Internet: 100341.240@compuserve.com

Fido: Walter Novacek@2:310/39.15

Pricing and Ordering Information






